EFL Teaching Application

How to Use Microsoft Office PowerPoint
Part 1 of 3: Creating a Presentation

1. Choose between a blank presentation and a template.

When you start a new PowerPoint file, you can either create a blank presentation or a template.
Blank presentations allow you to apply your own style, but this can be a time-consuming process.
Templates can give your presentation a uniform style, but they may not suit your exact needs.

You can edit any aspect of a template, so feel free to choose one that mostly matches your vision
and tweak it as you see fit.

You can apply themes to your project at a later time after you've added content. Click the Design
tab and select a theme. It will be immediately applied to your project. You can either undo it
(Ctrl + Z) or revert to a blank theme if you don't like it.

You can access templates from the File tab. Click New and then browse the available templates.
You can also download additional templates from a variety of resources online.

2. Create your title slide.

Your title is the first thing that your audience will see. It should be easy to read and give a basic
overview about the topic of the presentation. Most presenters will include their or their group's
name on the title as well.

3. Add new slides for content.

Press Ctrl + M for a new slide. A blank slide will be added after the slide you are currently on.
The slide will contain a title box and a text box. You can choose to use these or insert your own
objects using the Insert tab.

e When adding a text box, you can click and drag to make it whatever size you'd like. You
can then adjust this later by grabbing one of the corners with your cursor and then
clicking and dragging again.

e You can click on any text box and start typing to begin adding text to your presentation.
You can format text just as you would in Word, with formatting options available in the
Home tab.
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4. Navigate your presentation.

You can use the frame on the left side of the window to quickly scroll through your slides.
Clicking any of them will open that slide so that you can edit it. You can click the Outline tab to
see an outline tree of your presentation. Each slide will be labeled by the slide title.

5. Preview your presentation.

You can get a basic feel for the flow of your presentation at this point by pressing F5 to start the
slide show. Click the mouse to advance the slides. Use the preview slide show to get an idea of
how long the presentation is and how well information flows from one slide to the next.

Part 2 of 3: Jazzing It Up

1. Add transitions between slides.

Once you have some content in your slides, you can start adding some effects to help make it a
bit more interesting for your audience. Select a slide and click the Transitions tab. You will see a
list of the most common transitions. You can also click the arrow at the end of the list to open the
full listing of available transitions.

When you pick a transition, it will affect how that slide appears. For example, adding a transition
to Slide 2 will affect how Slide 1 transitions into Slide 2. You will be able to see a preview in the
slide editing window when you click each transition.

Avoid going crazy with a bunch of different transitions. This can be distracting to the audience
and keeps them from focusing on what's most important: your content.

2. Add backgrounds.

Plain white is boring. If your presentation is standard text on a plain white background, half of
your audience will be asleep before you reach the third slide. Use subtle backgrounds to add a
little visual flair to your project.

Right-click on a blank section of your slide and select "Format Background", or click the Design
tab and the click the arrow icon next to "Background" on the far right.

Choose your fill type. You can choose a solid color, a gradient fill, a picture background, or a
pattern fill. Selecting each choice will display several options for it, such as fill color, picture
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location, gradient settings, and more. Experiment until you find the background that fits your
presentation.

By default, the background will only be applied to your active slide. Click the "Apply to All"
button to apply your background choices to every slide.

Make sure that your text is still easily readable with the background you choose

3. Add images.

Adding pictures, diagrams, and other visual aids can help the audience grasp the ideas of your
presentation and drive your point home. Images break up the monotony of text and help keep the
audience from tuning out.

Click the Insert tab. There will be a large number of options when it comes to inserting objects.
Click the Picture button to insert a picture from a file on your computer. You can click the Photo
Album button to insert an entire album of photos into the slide as well.

Use the Charts button to insert easy-to-read charts that will help the audience understand your
data. Once you choose your Chart type, Excel will open, allowing you to enter in your data or
copy it from an existing spreadsheet.

Use the Shapes button to insert pre-made shapes or dray your own. You can use the shapes to
outline important text or create arrows and other visual indicators.

Avoid drowning your presentation with pictures. If it looks too busy, the audience will have a
hard time parsing your written information.

4. Add links.

You can add links to your slides that will allow you to quickly access websites or email
addresses. This can be especially useful if you are distributing the presentation and want people
to be able to easily view related webpages or send you an email.

To add a link, place your cursor in a text box and then click the Hyperlink button on the Insert
tab. You can choose to link to a file on your computer, a webpage, an email address, or even
another slide in your presentation.
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5. Embed video.

You can add video files to your slides. This can be useful for reports or any other video file that
may relate to your presentation. The video file will play when the slide appears.[1]

Click the Video button in the Insert tab. you will be able to browse your computer for video files.
While it's not as straightforward, you can embed YouTube videos as well. See this guide to learn
how.

Part 3 of 3: Making It Memorable

1. Keep the number of slides to a minimum.

Extremely long presentations will bore your audience, even if they are obsessed with your
subject matter. Extraneous slides with little to no content will also make the presentation drag
and wear on the audience's interest. Try to keep your presentation short and sweet, and make sure
you are using the space on each slide to it's maximum potential.

2. Choose a good font size.

Presentations are designed to be read, otherwise it would just be a speech. Make sure that your
audience will be able to easily read what you have written. A 10 point font may look okay when
you're sitting at your computer, but when it's projected on the screen, people may be leaning
forward in their seats straining to read.

On a related note, make sure that your font choice is readable as well. Curvy and extravagant
fonts may look cool, but they'll make your audience just stop caring if they can't read it.

3. Apply a consistent, subtle style.

The best presentations are those that have a consistent, deliberate style. use minimal amounts of
color and stylistic accents to make your presentation stand out without being garish. When in
doubt, use one of the templates for a guide.
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4. Triple-check for spelling and grammar errors.

If you misspell a word, you might not notice it, but someone in your audience will be sure to spot
it. Spelling and grammar mistakes will lower your credibility, even subconsciously, so you'll
want to work extra hard to ensure that everything is written clearly and correctly.

Get someone to help you proofread your presentation before you give it. A fresh set of eyes are
much more likely to catch mistakes that you gloss over.

5. Practice! The PowerPoint is only part of your presentation.

The other part is you! Take some time and practice your talking points as well as moving
through the slides. Work on your timing and ensure that each slide accurately sums up your
talking points. Make your own notes or memorize your presentation; reading off of your slides
while you are giving your presentation is a big no-no.
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Talking using a PPT

.l

Vocabulary

NOUNS
aids
attitude
complexity
content
equipment
eye contact
formality
gesture
handout
impact
interest
introduction
involvement
mannerisms
rhythm
sections
structure
visuals
voice
volume

VERBS
adjust
conclude
design
engage
establish
link
promote
provide
summarize

ADJECTIVES
allotted
confident
distracting
maximum
relaxed

relevant

ADVERBS
thoroughly
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1. What makes a good presentation? I

Checklist

Remember your audience

Establish clear objectives in the introduction
Meet audience expectations with relevant content
Create interest and promote involvement

Organize the information

Design an overall structure which is clear
Make sure that the introduction and ending have maximum impact
Link the different sections together
Communicate using the allotted time

Use visuals effectively

Use clear and simple messages

Create impact

Handle visual aids and equipment professionally
Be prepared to provide handouts

Communicate with body language

Maintain a relaxed attitude: remain confident and positive.
Use eye contact to engage your audience

Focus meaning by movement or gesture

Avoid distracting mannerisms

Avoid distracting
Deliver your message mannerisms.
Use your voice effectively: volume, rhythm and pause

Adijust complexity / formality of language to the audience

Prepare thoroughly
Write brief notes to assist

Practice before the real thing
Use your voice effectively.
Classic presentation organization
Greet > Tntroduce self - Wm:'q; i EXP:::sun stm::\‘:: of
v
mr;u; b&g Conclude > Summarize > Take questions
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Talking using a PPT

IINEREN 2. starting

Vocabulary Key Language for Introductions

40

NOUNS
aim
background
comments
flipchart
greeting
OHP
overhead projector
parts

points
position
sections
springboard
title

topic
whiteboard

VERBS
analyze
convince
divide
examine
move on to
outline
persuade
speak about
split

talk about

ADJECTIVES
brief

Chapter 2. English for Presentations

Greeting

Good morning /afternoon/ evening, ladies and gentlemen.
Welcome to Ericomm.

Hello/Hj, everyone.

Name and position

Let me just start by introducing myself. My name is Peter Wong.

As some/ most of you already know, I am Peter Wong.
I'm in charge of / responsible for production.
I'm the new CEO.

Title/subject

The title/subject/ topic of today’s presentation/ talk is ....
Today, I'd like to speak about ...

What I'd like to talk about is ....

Objective

The objective of this presentation is to present ....
This talk will act as a springboard for discussion.
The aim today is to give some background about ....

Main parts/outline
I've divided /split my talk into four main parts/sections.

First, what I want to do is give you some background ...
Second / Third, we will look at/move on to ....

Then/Next/ After that/Finally, I will speak about/examine ....

Visuals
I will be using the whiteboard and flipchart.
1 will be using the overhead projector.

Length of presentation

The presentation will take/last about ... minutes.
I will speak for about ... minutes.

I plan to be brief. About ... minutes.

Questions

If you have any questions, please feel free to interrupt.

Please interrupt me as we go along if you have any questions.
I'd be glad to take any questions at the end of my presentation.

Audience

1 know that you have all traveled a long way.
I'm very grateful that you could come today.
1¢’s nice to see so many faces.

1look forward to your comments on this.

Link to start
OK. Let’s start with the first point which is....
All right. We can begin by looking at ....

OK. Let's start
with the first

I've divided my talk into
e

Explain the structure.

This presentation ™)
will take about
three days. =

Link the different parts
of the presentation.

The Classic Introduction —

Checklist

= greeting

= name and position

= the title/subject

= the objective

= the main points

= mention visual aids
you will use

= time you will take

= when you would like

ons
= refer to your audience
= link to first section
Verbs to Explain
Objectives
inform introduce
describe outline
show examine
focus on look at
discuss persuade
convince analyze
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Talking using a PPT

I 3. signaling - linking the parts |
Sequencing ideas

First/Second / Third / Then/Next/Finally ....
The first/second / third / final point is ....

Third, having looked at
customers and markets,
the next issue is pricing.

NOUNS
argument
audience Ending a section
Qomments Right/So/Well /OK ....
'dei:t That's all I wanted to say about ...
tpl.;aughts I think that covers everything on .... Sequence ideas clearly.
diseitanis I think that deals with ...

To summarize,....
VERBS T think that covers everything ™
clarify Intermediate questions about our no smoking policy.
comaback Are there any questions or comments on that? et anr? q;f'y
cover y on that
deal with Would anyone like to ask a question at this point? , '
digress 4 p
st Opening a new section
signal Let’s now look at ...
turn to Now [ want to turn to ....

This brings me to the third and final point whichiis .... '
ADVERBS Close points clearly ar:d
‘;l'ea“’r‘l;w“' Exploring a list of points e padlb

In relation to ....

Regarding ... Another factor

Concerning .... in our decision

to relocate to
With respect to .... Nihali vige
Adding ideas

In addition to this .../ Moreover ....
However .../ Despite this ...
S0 ..../ Therefore ....

Digressing

If I could just digress for a second, ....
I would like to look at ... in passing.

By the way ..../Incidentally ...

Going back
Let me now return to ...
Let me now come back to ....

Presentation tips
Signaling will:
= dlarify the structure of your talk

If | could just
digress again for
a second...

Respect your audience.

= help the audience to understand what you are saying
= help to organize your thoughts as you give the presentation
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Talking using a PPT

44

|EMB B 4. Highlighting and emphasizing
n—

I'd like to emphasize ...

I'd like to stress ...
:ggtﬁm I should reiterate/repeat ....
conftrast It is critical / essential to understand ...
disaster
improvement ‘What’
(l;;);(v)vnord What we can’tdo is ....
repetition What I'd like to do is ....
solution What we have been able to do'is ....
team work What is really important is ...
VERES Repetition
achieve ‘
emphasize This is a very, very difficult problem.
highlight We thought for a long, long time about this.
reiterate We need to do something and we need to do it now.
simplify
stress . g .»

Simplifying
ADJECTIVES To be honest,.... / Frankly speaking,....
absolute Basically,..../To put it simply,....
brilliant Believe me,....
complex
critical "
dramatic Analyzing
essential Let's look at this more closely.
g::g::::i;g What does this mean exactly?
teiraikabte In other words,....
simple
Articulation - stressing

:W‘:EBS Auxiliary verbs — do / does | did
c::;fun);, We did achieve many things last year.
closely It does seem to be the best solution.
exactly We did think very carefully about this.
frankl
:::mpeat);dly Key worq.r' )
simply I agree, it is important.
totally We have tried repeatedly, believe me.

There is a lot of room for improvement.

Dramatic language

A total /absolute/ complete disaster
A great/outstanding / remarkable success
Totally unacceptable /Quite brilliant

Contrast

Actually ..../In fact ..../In reality ..../ The truth is that ....

Yesterday it was easy. Today it is far more difficult.

Chapter 2. English for Presentations

el
Qimponance of team work.

Id like to emphasize

Repeat in order to highlight.

To be honest, we have no option!

My first idea didn’t work.
But this idea can't fail,
believe me!

Use dramatic coA

Little words:
Big impact

Itis so simple.

Itis really easy.

It is far too difficult.
It is simply brilliant.
Itis no problem.
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Talking using a PPT

IIBBE Y 5. Engaging your audience |

Vocabulary Rhetorical questions L/ls money re

Are we satisfied with this product?
NOUNS Do we really want to downsize?

Is this company growing fast enough?
8 v hadlo Can we afford to ignore this problem?

clarification

diplomacy . 2

expectation Offer clarification

(ac"shbo Is that clear?

;Z'f“ S w Are there any questions about that? .

rapport I'm sure some of you want to take me up on this.

specialist = _ =

statistics Directing questions

VERBS George, I know you have a lot of experience.
aiad Could you comment?

::for dw e Perhaps, I can ask Peter to answer that question? Peter?

AR I'd like to try an experiment.

ignore Could you ask your neighbor ...?

lead to Can I ask for a show of hands?

offer How many people ...?

spend time on How many people here have ever ...?

tend to

ADJECTIVES Creating rapport

diplomatic We need to ....

recent We don’t need to spend time on this.
rhetorical I know what you are thinking.
satisfied

I'm sure everyone in this room ....

Interesting facts
Did you know that ...?

According to a recent study ... Gis is what we call
a mobile phone.

I read somewhere that ...

Statistics show that ....
S N re—
Interesting examples R oD |
For example ... seethat .. el
2 ience are
For instance .... specialists tool
As an example .... <
Acknowledge ) )
I'm sure you don’t need me to tell you that .... 5:: zml e
I realize you all know ... P "
Diplomacy - softening Quick tips
I tend to think that ... Build a rapport with your audience:
It seems to me that .... = Use “we” not 1" .
It may be a little/bit difficult. = Understand their point of view.
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greatest motivator?

ally the

Rhetorical questions create
variety and expectation, leading
to an interested audience!

Are there w

Did you know that 10% of the
U.S. population is vegetarian?
/\—/
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Talking using a PPT
;AR

Vocabulary Introducing the visual

OK. Let's take a look at ....
I have a transparency to show you.

Equipment and
environment
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NOUNS The first/second / next/ final slide is ....
aspects -
bar chart Check with the audience
cole Is that _clear for7everyone?
diageam Is that in focus?
first glance Can everybody see that?
mdamﬁml Meaning of the visual
layout This shows/illustrates / demonstrates / refers to ....
map This is a graph/a diagram which shows ....
marker As you can see, this is ....
meaning Here we can see ...
OHP .
pie chart Focusing attention
plen = I'd like to draw your attention to ...
g::enter One of the most important aspects of this is ....
shape At first glance it seems ... but ....
lide
sl
table Type of
transparency visual
visual
VERBS
comuinunicate Ui rovh
distract
draw attention to
illustrate
ADJECTIVES
compatible
logical
shaded
technical

"Il.- 6. Visual aids — design and type

Tllustrate things
you can't say in words.

Why use a visual aid?

Saves time

Highlights key points

Creates impact

Helps the presenter

Creates variety

Builds interest

Spot check —visuals

= Are spelling and grammar correct?
= Is lettering dear?

= [s the layout logical?

» Are the colors compatible?

= Does it communicate or distract?
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Talking using a PPT

NOUNS
deterioration
fluctuation
peak
recovery

slump

VERBS
deteriorate

fall

fluctuate
improve

reach a low point
recover

rocket

slump

worsen

Describing change
Up

Down

ADJECTIVES
gradual
rapid

significant
slight
stable

ADVERBS

consequently
gradually
significantly
slightly

up down

To goup q To go down
Toincrease  anincrease To decrease a decrease
Torise arise ’ / To fall afall \
To grow agrowth To drop adrop
Toimprove  animprovement To deteriorate  a deterioration
To get better rocier To get worse Shimp
To recover a recovery To worsen aworsening
To rocket ' % To slump aslump \
Others
To remain stable peak fluctuate
To level out To fluctuate  a fluctuation
To reach a peak ‘ /\ To bottom out V\/\
To peak apeak To reach a low point

L Tohitalow  alow L

Speed of change
Rapid - Rapidly
Steady - Steadily |
Gradual - Gradually ‘
Sow - Slowly | / |
Degree of change Sales rose rapidly. Sales rose dramatically.

Dramatic - Dramatically There was a rapid rise in There was a drematic rise
Significant — Significantly sales. in sales.

Moderate - Moderately
Slight - Slightly

Prepositions
To stand at
From ... to ...
By ...
An increase of ....

Giving explanations

Sales rose from 3 million
to 7 million.

Sales rose by 4 million.
There was an increase of
4 million over last year.
Sales stood at 3 million in
January.

The cause

| 7. visual aids — describing charts |

Vocabulary

This happened because ....
This was a result of ....
S0 .../ Therefore ....

This will lead to ....
Consequently ..../ As a result ..

50 Chapter 2. English for Presentations
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Illl.- 8. Body language - being persuasive
s

Match your appearance to audience expectations

Maintain eye contact
NOUNS Use positive facial expressions — smile
advantage Move to create interest
;}:g’em Use hands to create impact with gesture
di s::v atage Establish a confident posture and stance
expression Create a positive attitude — be relaxed and enthusiastic
gesture
postu:e
F{“:P"Sa' Persuading language
1101
stance Proposing
suicide I suggest that we ....
My suggestion is that we ....
VERBS I recommend that we ....
convince My recommendation is that we .... Smile
'?:.'l:"""‘ [ propose that we ....
smau .
e 2 Tealk My proposal is that we ...
ADJECTIVES Advantages
absolute The difference between ... and ... is enormous.
enormous What are the advantages and disadvantages of ..?
enthusiastic On the one hand ..../On the other hand ....
facial This is far superior to ..../better than ....
risky {L;t/sm ’
stark the advantages.
superior Stark options s f_,,__g./ f
We have no choice. X

If we don’t ... then we will see ....
Either we ....or ....
Instead of ... we could ....

Neutral vs emotive words

Neutral Emotive

It is risky. It is commercial suicide. Marketing this product
This may be a problem. This will lead to chaos. would be commercial
We require this. This is an absolute must.

Some will complain. There will be a riot.

Say it three times!
m 2 &)
This new product is faster, cheaper, and more efficient.
This supplier is friendly, customer-focused, and next door!
] (2] 3]

Presentation tip
Practice the introduction until it is perfect.
You need to convince your audience in the first sixty seconds!
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NOUNS
approach
catastrophe
competence
performance
strength
style
weakness

VERBS
balance
concentrate
exaggerate
overstate
perceive
translate
utilize

ADJECTIVES
balanced
detached
emphatic
impersonal
in-depth
organic
systematic

Chapter 2. English for Presentations

"l..- 9. Communicating styles

People have different communicating styles. Understanding how you communicate is
important to improve your presentation planning and performance. Consider your own
style by asking yourself the questions in the table below. Remember —there is no right or
wrong way but you should have a balanced approach.

Communication factor Personal profile
; ; Do you prefer structured presentations to a more
tic vs
Systematic vs Organic GrRRNICatyIE
Do you prefer formal | age, dress, toan
Fe youp anguage, , posture
ormal vs Informal i approadi?
Closed vs Open Do you state facts or ask questions and discuss answers?
: ' Do you enjoy in-depth analysis or communicatin,
Complex vs Simpl y Joy in-dep ysis 8
D GRS simply and efficiently?
Emphatic vs Relaxed Do you tend to overstate and exaggerate or just
concentrate on the facts?
Involved vs Impersonal Do you engage emotionally with your presentation

subject or remain detached?

Language choices
Now examine some of the ways in which differences in communicating style translate
into differences in the language which we use.

1. Choose between formality and informality

Formal Phrases Informal Phrases

Good morning ladies and gentlemen ... vs  Hello, everyone ...

On behalf of ... may 1 welcome youto...  vs  Thanks for coming.

If I may, I'd now like to moveon to .... vs  OK Secondly,....

If you have any questions, feel free .... vs Justinterrupt with questions.
Formal Vocabulary Informal Vocabulary

Sales have recovered. vs  Sales have picked up.

We will acquire the company soon. vs  We will buy it soon.

We perceive it differently. vs  Wesee it differently.

We must utilize our competence. vs  We must use our competence.
2. Balance personal against impersonal

Tense Passive - Impersonal Active - Personal
Present simple It is thought I think

Present continuous Tt is being examined We are examining
Present perfect It has been claimed An expert has claimed
Past simple It was arranged I arranged it.

Future This will be looked at later. 1 will look at this later.
3. Balance ‘stating’ against ‘questioning’

Itis clear that .... vs Would you agree that ...?

I don’t think that ... vs Do you think that ...?

We must ... vs Isthere any way to ...

4. Balance ‘emphatic’ against ‘relaxed’

This is a really big problem  vs  This is a slight worry
This is a catastrophe vs This may cause a problem
I am convinced ... vs [tend to think that....
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"l..- 10. Closing a presentation I
Signaling the end i)

OK. That brings me to the end of my presentation. \ofmiesen’tition.
) 7

Right. That covers everything I wanted to say about ....

NOUNS .
S So, that's all Thave to say.
handout
recommendation
Summarizing
VERBS To sum up then,....
advise A
conclude Inbnef,...: X 3
expect Before I finish, let me just go over ....
follow up If I can briefly summarize,....
go over
invite
recommend .
sum up Concluding
summarize To conclude, I'd like to say that ....
I'd like to finish by saying ....
ADJECTIVES In conclusion,....
final
ADVERBS 3
attentively Final recommendation
briefly It seems to me, then, that we should ....

I would therefore recommend /advise that ....

Support
I have prepared a handout which I will pass round.

I'll give you my e-mail address in case you want to follow
up on something I said. @‘

Closing
Thank you for listening so attentively.
Thank you for your attention.
I hope that this has been useful.

Inviting questions

I'd be glad to answer any questions.

So, do you have any questions?

Are there any questions?

Yes, the gentleman /lady sitting there. [points]

Presentation tip
Prepare answers to questions which you expect.
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"'I.- 11. Handling questions

Vocabulary Questions for the presente
What did you mean
that...?
NOUNS

when you said .7 for me.

criticism

VERBS Thank you for asking that question.

catch I'm glad someone asked that question. It allows me to say ....
depend on

follow Check your answer

hedge Does that answer your question? /Is that OK?

2::23:‘“ Is that clear now? /Can we move on?

DEpa You're asking me about .... Is that right?

IVES Sorry 1 didn’t follow / catch the question.
Q)?I{Eg Could you repeat that for me, please?
comglicated In other words, you're asking ... 'f;'"demyﬁyrg“
So;fr;ﬁif:mal Refer back asking me about ...
fair As 1 said earlier, in the first section/at the end of the second section ....
glad Yes, I mentioned in the introduction ....
interesti ans e
;‘osiﬁveng Accept criticism

I accept that./ That’s a fair point. /I agree with what you're saying.

ADVERBS Up to a point, | agree.
correctly

Referring back to the presentation
As said / pointed out/explained earlier,....

1. Wrong person
I'm afraid I can’t really answer that.
That's not really my area/field, I'm afraid.

2. Wrong topic

I"d be glad to discuss that with you personally after the presentation.
3. Tennis — returning a question

Well, let me ask you the same question. I"d be fired if |
OK. Let me ask you a question. told you that!
1 can answer that by asking you a question.

4. Hedging

58 Chapter 2. English for Presentations

Could you go over that again,
please? It wasn't very clear

I think we've already made it clear that .... .
e | should have done )< < <
Avoiding: more preparation. AT

area Could you say a little bit more about ...? ' Don't you think that ...?

field ope

respome Positive response I wish you hadn't asked that.
That's a good / difficult/ complex/an interesting question. ')

N

That's an interesting question.

p(;int out Clarify m
faigs If T understand you correctly, you want to know ... at do you
(=]

mean?
<D
(@)

i

1don’t have the figures with me. That's not really my field.
St

T'm afraid that question goes beyond the subject of today’s presentation.
I'm afraid that’s confidential. /I'm not at liberty to give you that information.

OO o

|

Well, that depénds on what you mean by .... R f
Well, it's a very complicated matter .... -
Well, there are various ways of looking at it. I'm afraid that is confidential. )
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Vocabulary

NOUNS
body
ending
greeting
introduction

length
VERBS

close
digress
greet
handle
highlight
introduce
open
outline
sequence
signal

state

ADJECTIVES
positively

Chapter 2. English for Presentations

Introduction

"l..- 12. Presenting at a glance

Good morning. The objective of my
Welcome to.... j B ( Mynameis... ) «weo > presentation today is ....
Greet Introduce yourself State objective F
i
OK. To begin salssssisr Feel free ) ....... Iwill take ) gq........ I've divided the talk
I'd like to look at .... to interrupt. 15 minutes. into five sections ....

Main Body

So, the first part of
my presentation is ....

Part one

Here, | would like
to highlight two

Highlighting

._“

As you can see on
this chart ....

Using a visual

That brings me to the
end of my presentation.

Signal end

If there are no
more questions,
I'll finish there.

Closing

Questions .

So, that's all | have to
say on the first point.
Any questions on that?

Closing first part

OK. That's every thing
on Part Two. | will now
move on to Part Three.

Closing/moving on

=# (" Iwould suggest ....

Recommending

OK, that’s all | wanted
to say on Part Three.

Closing

Handle questions
positively

That's a good <
. question.

OK, let's move on to
- _the second section which
I have called ...

There are two
questions to look at
here: firstly ....

Sequencing

........ > Could | digress
for a second?

Digressing

'

Let me now
return 1o ....

Returning

In conclusion,
| would like to say ....

Conclude

Arethere L &~
any questions?

Invite questions
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"l.-- 13. Cross-cultural tips
Remember...

Audiences have very different expectations in different cultures. Knowing what your
audience expects from the presenter is critical to successful presenting. When preparing
and planning presentations for specific audiences, you should consider the following:
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NOUNS
analysis
animation
dress code
factor
hierarchy
host
hostility
interaction
interruption
lack
organization
personality
pocket
precision
professionalism
punctuality
role
sloppiness
spontaneity

VERBS
bear with
consider
contribute
interrupt

ADJECTIVES
dynamic
irrelevant
reserved

rigid

specific

strict
sufficient
suitable
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Involvement Factor

Interaction:

Role of silence:
Interruption:
Human touch:
Punctuality:
Formality:
Animation:
Level of analysis:

Some audiences simply want to listen and not contribute.

Some audiences use silence to communicate agreement, not hostility.
Some audiences expect to be able to interrupt.

Some audiences like to see the personality of the presenter.

Most audiences respect punctuality.

Some audiences see informality as a lack of professionalism.

Some audiences prefer a reserved style to over-enthusiastic presenters.
Many audiences have in-depth specialist knowledge.

Organization Factor

Systematic:
Support:
Digression:

Some audiences prefer an organic style to rigid structure.
Some audiences don’t want a lot of visuals and handouts.
Some audiences see digression as irrelevant.

Body Language Factor

Hands:

Eye contact:
Dress:
Body:

Face:

Delivery Factor

Language:
Reading text:

Voice:

Social Factor

Some audiences view hand(s) in pockets as sloppiness.

Some audiences feel uncomfortable without eye contact.

Some audiences work in companies and cultures with strict dress codes.
Some audiences expect a presenter to be dynamic.

Some audiences look for animated facial expressions.

Some audiences have a limited English vocabulary.
Some audiences favor spontaneity over precision.
ALL audiences need sufficient volume and a suitable speed.

Names: Some audiences prefer family names to first names.
Business card:  Some audiences will request a business card.
Host thanking:  ALL audiences expect basic courtesies. Be polite.
Hierarchy: ALL audiences respect social and corporate hierarchies.
Survival strategies
Situation Language
The audience doesn't understand. Let me go over that again.
You forgot! Perhaps I should mention ...
No vocabulary! I'm sorry, what's that word again?
You are lost. Now, where was I?
You drop your slides! Please, just bear with me a second.
No time. So, the main point is ....
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||Il-- 14. Golden rules
Practice and rehearse key English phrases.

NOUNS DO

anecdote . L.

assumption = establish a clear objective.

clarity = talk about what your audience expect you to talk about.
facilities = organize the information.

impact = use notes or key words to assist.

;'O‘I:“"‘m“ = have a strong opening and closing.

= make it interesting.

location f
RREEREm = use your voice for effect.
overhead = keep it simple.
preparation = use visuals which improve impact and clarity.
spontaneity = handle equipment professionally.
bk = speak with sufficient volume and intonation.
view . 5
ol = use summaries to link the parts.
= think about the cultural environment.
VERBS = dress for the occasion.
block = prepare and practice beforehand. =
establish = be confident and relaxed. Ude vismals whishii
PhOt?COPY = balance spontaneity and preparation. impact and clarity.
practice = handle questions positively.
distracting = make assumptions about the location and facilities —check beforehand.
inappropriate = present information which is too complex for the audience.
scripted = talk for too long.
Sty = tell irrelevant anecdotes or inappropriate jokes.
ADVERBS s spiedktaio gickly.
foaiively = use too many visuals.

professionally = photocopy small text onto an overhead.
= read from a scripted text or visuals.
= block your audience’s view of a visual.
= talk with your back to the audience.
= use distracting mannerisms.
= forget to summarize at the end.

Don't block your audience’s view.
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